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Working with Pictures

PowerPoint  makes it easy to insert pictures both from your com-
puter and from online locations. You can format inserted pictures in 
dozens of ways in PowerPoint. Apply a picture style to get a com-
plete look with one click. Add a color tint to a series of random pic-
tures to help them look more cohesive. Crop to fit your slide, drop 
out backgrounds, correct fuzziness—the list goes on and on.…

Images can help tell your story and engage your audience, but you 
want to be careful when sourcing them. Make sure that the picture 
tells the story you’re trying to tell and that it’s appropriate for the 
audience.

Especially   when searching online, you must be careful not to vio-
late copyright laws. Just because an image is on the Web doesn’t 
mean you have the right to use it in your presentation. Although 
PowerPoint searches by default for images available for use through 
Creative Commons licenses, in many cases, you’re better off pur-
chasing inexpensive royalty-free stock photos.

In this chapter, you will learn about inserting 
and formatting pictures. Specific topics in this 
chapter include the following:

  ➔ Inserting pictures

  ➔ Cropping and resizing pictures

  ➔ Formatting pictures

  ➔ Compressing pictures

  ➔ Creating a photo album
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Insert Pictures from Your 
Hard Drive
If    you’ve already downloaded a pic-
ture to your hard drive, here’s how to 
insert it.

 1. Insert a new slide into your pre-
sentation. Choose a layout that 
uses a content or picture place-
holder.

 2. Click the Pictures icon in the 
placeholder. Alternatively, click 
the Pictures button on the Insert 
tab of the Ribbon.

 3. Find the picture on your com-
puter. Select it and click Insert.

Choose the Correct Layout
When   there is an empty content or 
picture placeholder on your slide, 
PowerPoint fills it with the picture 
even if you use the tools on the 
Ribbon to insert the image. If you 
don’t want this to happen, choose 
a layout such as Title Only or Blank 
that doesn’t have content or picture 
placeholders. Otherwise, you can 
temporarily fill the placeholder with 
text or other content—even just a 
space will work—and delete it after 
you’ve inserted the picture.

Inserting Pictures
There are quite a few ways to insert pictures onto a slide. You can use the picture 
tools on the Insert tab, you can use content placeholders, and you can use pic-
ture placeholders. We’ll discuss all of these methods and more in this section.

2

1
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Insert Online Pictures
With    Online Pictures, you can search for pictures online or insert them from OneDrive and 
other online storage.

1

2

4

 1. Insert a new slide into your presentation. Choose a layout that uses a content or pic-
ture placeholder.

 2. Click the Online Pictures icon in the placeholder.

 3. Alternatively, click the Online Pictures icon on the Insert tab of the Ribbon.

 4. If the picture is stored on OneDrive, click the Browse button to see your files and fold-
ers on OneDrive.

 5. If the picture is stored on Facebook or Flickr, click the icons at the bottom of the Insert 
Pictures dialog box to connect to your account.

 6. If you don’t already have an image, you can search for pictures using Bing Image 
Search. Enter the search terms and press Enter to begin.

6

5
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Adding Places
If your images are stored in a location that isn’t listed in the    Insert Pictures dialog box, 
you may be able to add the location. To do so, click File, Account, Add a Service to see 
options for adding YouTube, LinkedIn, Twitter, and SharePoint accounts, among others.

 7. Note that the initial search results in images that are available to use under Creative 
Commons licensing, as explained in the informational banner. Specifics about the 
image appear in the lower-left corner of the Insert Pictures dialog box. Click that link 
to go to the image site and double-check for any license restrictions or attributions 
you must include when you use the image.

 8. Click the X to minimize the informational banner about Creative Commons search 
results so you can see more thumbnails in the dialog box.

 9. Clicking Show All Web Results removes the search filter that shows you only images 
licensed under Creative Commons. Be careful if you do this! You’ll see more results, 
but you will need to check the copyright and any license restrictions for each image 
to ensure you’re not using it illegally. In most cases, you should purchase the image in 
order to use it.

 10. Hover over a thumbnail and click the magnification icon to see a larger thumbnail.

 11. Click a thumbnail to select it and then click Insert to add it to your slide. Press Ctrl and 
click thumbnails to select multiple images or use Shift+click to select a contiguous range.

What Is Creative Commons?
   Creative Commons gives photographers and other artists a free, standardized process to let 
the public use and share their creative work. There are many levels of Creative Commons 
licensing: Some levels require attribution, some allow only noncommercial work, and so on. 
To learn more about this, look up Creative Commons in your favorite search engine.

10

8

9
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Insert Screen Captures
Use    this feature when you want to include a screenshot in your presentation and don’t have a 
screenshot utility handy.

 1. On the Insert tab, click Screenshot.

 2. Other open applications appear in the Available Windows gallery. Click a thumbnail to 
add it to your slide.

 3. Or click Screen Clipping to take a quick snapshot of part of the screen. PowerPoint 
automatically takes you to a view of the screen as it was just before you switched to 
PowerPoint and clicked Insert, Screenshot.

 4. When the screen ghosts and your mouse pointer becomes a crosshair, click and drag 
to indicate the area of the screen to capture. When you release the mouse button, the 
screen grab will be inserted onto your slide.

3

1

2
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Tips for Using Insert Screenshot
If a window or an application is minimized, it won’t appear in the  Available 
Windows gallery. Use the buttons on the Windows taskbar to switch to the 
application, size and position its window, and then immediately switch to 
PowerPoint and click Insert, Screenshot.

If the window or application still doesn’t appear in the Available Windows gal-
lery, use Screen Clipping to snag it. Use the same process to size the window; 
then click the button on the Windows taskbar to move back to PowerPoint and 
click Insert, Screenshot, Screen Clipping.

Turn Pictures into SmartArt
Some    SmartArt graphics have picture placeholders that you can click to add images from 
your hard drive or online storage locations. (You’ll learn about this topic in Chapter 6, 
“Creating Diagrams and Tables.”) If you already have pictures inserted onto your slide, 
though, use the following technique to turn them into a SmartArt graphic.

Windows taskbar

 1. Select the picture(s) on the slide. The Picture Tools Format tab will become available.

1
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 2. On the Picture Tools Format tab, click Picture Layout and then choose a SmartArt lay-
out from the gallery. Remember that you can point to different selections in the gal-
lery to preview the effect on the slide before you click to apply a SmartArt layout.

 3. Complete the SmartArt diagram by adding text, changing colors, or even changing to 
a different Picture diagram layout on the SmartArt Tools Design and Format contex-
tual tabs that appear when you select the SmartArt graphic you just created. To learn 
more about formatting SmartArt graphics, see Chapter 6.

Cropping and Resizing Pictures
It’s important to learn to crop and resize pictures properly rather than simply 
stretching them to fit into a space. Not only does this avoid the warped “fun-
house mirror” images that result from stretching, but a good crop will often 
increase the drama factor of your image and make it stand out that much 
more. You can also crop pictures into shapes such as an oval or a rounded 
rectangle.

2

3
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Resize Pictures
Always   resize pictures proportion-
ately; otherwise, people and objects 
will look too wide or too narrow.

 1. Insert a picture onto a slide and 
select it. Click and drag a corner 
handle of the image to resize 
smaller or larger.

Press Shift to Maintain 
Proportions
Press  Shift while you drag a corner 
handle to prevent stretching and 
keep your picture in proportion.

 2. Don’t drag from any of the side 
handles; this will distort the pic-
ture even if you do press Shift!

Fitting a Square Peg into a 
Round Hole
If your picture isn’t sized right for 
the space it should go into, then 
you’ll need to crop it. You may want 
to use the Crop to Aspect Ratio 
tools, which are covered later in this 
section, to make this job easier.

 3. If your picture is  distorted, click 
Reset Picture on the Picture Tools 
Format tab, and then click Reset 
Picture & Size. The Reset Picture 
option above it removes artistic 
effects and other formatting 
options, but it doesn’t restore the 
proportion.

1

2
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Resizing by the Numbers
If you know the width or height you 
want the image to be, input one of 
those values on the Size group of 
the Picture Tools Format tab and 
press Enter. Your picture should 
resize proportionately.

If it doesn’t, right-click the picture 
and choose Format Picture. In the 
Format Picture pane under Size 
& Properties, click Size to expand 
those options. Make sure Scale 
Height and Scale Width are the 
same value, and then click Lock 
aspect ratio to keep everything in 
proportion when you resize.

Crop Pictures
Use   PowerPoint’s crop tools to get rid of 
parts of pictures and help them better 
fit into their designated space. Insert a 
picture onto a slide to get started.

 1. Select the picture and click the 
Crop button on the Picture Tools 
Format tab.

 2. Crop handles will appear on the 
sides and corners of the image, 
indicating that you’re ready to 
crop.

 3. Move your mouse pointer toward 
a crop handle. When it turns into 
a black crop tool, click and drag 
the crop mark to crop the picture.

 4. Notice that cropped areas of the 
picture will become semitranspar-
ent so you can easily see what 
you’re cropping out and what 
you’re leaving in.

Format 
Picture 
pane

Shape 
Height

Shape 
Width
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 5. After you’ve positioned the crop 
handles, you may want to resize 
the picture inside the crop frame. 
To do this, click and drag one 
of the round corner handles. If 
necessary, press Shift to keep the 
picture from distorting.

 6. To reposition the picture inside 
the crop frame, click anywhere 
on the picture. When the cursor 
becomes a four-headed arrow, 
drag it into position.

 7. When you’re finished, click away 
from the picture, press Esc on 
your keyboard, or click the Crop 
button on the Ribbon to apply 
the crop.

5
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When you’re cropping by the numbers, it helps to think of the crop as a frame sitting on 
top of the picture. You can adjust either the picture or the crop frame itself.

Picture Position Width and Height settings indicate the size of the original picture. You prob-
ably don’t want to change either value here because the aspect ratio isn’t locked the way 
it can be in the Size & Position settings. If you change one value, the other one won’t auto-
matically change proportionately, and your picture will become distorted.

The Picture Position Offset X and Y settings indicate how far off-center the picture is inside 
the crop frame. For example, if Offset X and Offset Y are both zero, the picture is exactly cen-
tered inside the crop frame. Changing these settings moves the picture inside the frame.

The Crop Position Width and Height settings indicate the size of the crop frame, which is 
also the size of the cropped picture. Changing these settings changes the size of the frame. 
If you make either one too big, it may be larger than your picture, in which case it will look 
like the picture is cut off. If this happens, you can always resize the picture inside the crop. 
See step 5 in this exercise for the easiest way to accomplish this task.

The Crop Position Left and Top settings indicate the position of the crop frame on the slide. 
Input 0 for Crop Position Left, and the crop frame will be flush with the left edge of the slide. 
Add a 0 for Crop Position Top, and the crop frame is flush with the top edge of the slide.

>>>Go Further
CROPPING BY THE NUMBERS
If you    need finer control than the crop handles can give you, or if you want to further refine 
a rough crop you did with them, use the Crop settings in the Format Picture pane.

Right-click the picture and choose Format Picture (to open the formatting pane), and 
then click the Picture icon. Click Crop to expand those settings.

Picture
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Crop to Aspect Ratio
Crop to    Aspect Ratio is the fastest way to create pictures that will perfectly fit your slide. 
To begin, insert a picture onto your slide and select it.

 1. On the Picture Tools Format tab, click the Crop button arrow, point to Aspect Ratio, 
and then choose 16:9.

1
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What Are All These Aspect Ratios?
The  aspect ratios listed in the Crop to Aspect Ratio settings are typical slide and picture 
proportions. To crop a picture so it fills a widescreen slide, choose 16:9. To fill a 10" х 7.5" 
slide, which was the default in PowerPoint 2010 and prior versions, select the 4:3 aspect 
ratio. For a perfect square, click 1:1.

 2. Crop marks will appear so you can see how the picture will be cropped in order to 
fit the desired aspect ratio. Resize and reposition the picture inside the crop frame if 
necessary. See steps 5 and 6 in the previous exercise for instructions.

 3. Click the Crop button again when you’re finished cropping.

 4. If necessary, select the picture again to resize it. On the Picture Tools Format tab, 
input 7.5 as the Height value and press Enter. Assuming you cropped to the 16:9 
aspect ratio, the width will automatically change to 13.33". If you cropped to the 4:3 
aspect ratio, the width would automatically change to 10".

 5. Drag the picture into place to cover the slide or use the Align tools to position it.

Crop to Shape
You    can fill a shape with a picture, but sometimes it’s easier to crop the picture into a 
shape. To begin, insert a picture onto your slide and select it.

 1. On the Picture Tools Format tab, click the Crop button arrow, and then point to Crop 
to Shape.

 2. Select a shape from the shape gallery that appears. The picture will be cropped to the 
selected shape.

1

2
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 3. If necessary, select the picture again and click the top of the Crop button so you can 
resize and position the picture within the shaped crop frame. Use the instructions in 
steps 5 and 6 of the Crop Pictures exercise.

 4. Apply more formatting as desired, for example, soft edges or artistic filters.

How Can I Crop a Picture into a Circle?
To  crop a picture into a perfect circle, first use Crop to Aspect Ratio and choose Square, 1:1. 
Then use Crop to Shape and choose the oval. An oval with a 1:1 aspect ratio is a circle.

>>>Go Further
WHAT ARE CROP TO FILL AND CROP TO FIT?
At the    bottom of the Crop button menu are options for Fill and Fit. You can use 
these with pictures inserted into picture placeholders, such as the one on the 
Picture with Caption layout. Insert a picture on this layout and you’ll see that it fills 
the placeholder and crops the excess areas of the picture that don’t fit. Use Crop, Fit 
to show the entire picture in the picture placeholder area. Use Crop, Fill to go back 
to filling the placeholder.

Formatting Pictures
Because   pictures are treated mostly as shapes on a slide, you can use many 
of the same formatting options on them as you can on shapes. For example, 
you can add a border to your picture and change its color and width. Or you 
can add a reflection, a shadow, or soft edges by selecting these options from 
the Picture Effects galleries—just as you would select them from the Drawing 
Effects galleries to apply them to a shape.

Since you already know how to apply those effects, in this section we’ll 
concentrate on the additional options that PowerPoint reserves strictly for 
pictures. Adjusting brightness, contrast, and sharpness may not completely 
save a really bad picture, but it might make the difference between one 
that’s usable and one that’s not. Artistic effects make your picture look like a 
sketch or painting, which may add some interest to your presentation. And 
recoloring pictures is an easy way to help make them feel as though they go 
together. Unleash your inner artist!
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Apply Formatting with Picture Styles
Picture styles    provide combinations of shapes, borders, and shadows to apply to your 
pictures with one click.

 1. Insert a picture onto your slide and select it.

 2. On the Picture Tools Format tab, click the More button to expand the Picture Styles 
gallery.

 3. Click a style from the  Picture Styles gallery to apply it.

 4. To resize or reposition the picture within the Picture Styles frame, click the Crop but-
ton and follow the instructions in steps 5 and 6 of the Crop Pictures exercise.

 5. To remove the Picture Style formatting, click the Reset Picture button on the Picture 
Tools Format tab.

5
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Remove Picture Backgrounds
Removing the     background of an image lets the slide background appear instead. For 
example, if your slide has a dark background, you might want to remove a white back-
ground from a corporate logo image.

11
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 1. Insert a picture onto your slide and select it.

 2. On the Picture Tools Format tab, click the Remove Background button.

 3. Notice that parts of your image will be colored magenta. The magenta parts of the 
picture will be removed.

 4. The internal frame gives PowerPoint a general guess as to what you want to keep. 
Dragging the handles to resize and position that frame may help PowerPoint select 
more appropriate areas to discard. It doesn’t hurt to try, anyway!

 5. If parts of the picture you want to keep are colored magenta, click the Mark Areas to 
Keep button, and then click and drag on that area in the picture so it becomes colored 
again. Zoom in if necessary, and use as many “keep marks” as you need. “Keep” marks 
appear with a + symbol.

 6. If parts of the picture you want to be discarded are not colored magenta, click the Mark 
Areas to Remove button, and then click and drag on those areas in the picture. Zoom in 
if necessary, and use as many “remove marks” as you need. “Remove” marks appear with 
a – symbol.

 7. Click Delete Mark and then click on a mark to remove it.

 8. Click Discard All Changes to start over.

 9. Click away from the picture to deselect it or click the Keep Changes button when you’re 
finished.

Refining the Image
If a lot of empty space is left around the edges of the image when you’re finished, you can 
crop the picture. Use the instructions in the Crop Pictures exercise.

 10. Apply effects such as color or artistic filters if you want.

 11. To remove all changes to the picture, click the Reset Picture button on the Picture 
Tools Format tab.

It’s Not All Good
The  Remove Background tool can be super finicky. Sometimes when you 
add a Keep or Remove mark or resize the internal frame, another area of the 
image reverses itself and either becomes visible or turns magenta (indicating 
it will be discarded). The only thing you can do to help this is to pay attention. 
If you know which mark is causing it to happen, you can delete that mark and 
add another in a slightly different place or at a slightly different length.

If you’re having trouble getting into the nooks and crannies of a picture, try 
using the Picture Effects to add a 1- or 2.5-point soft edge. Sometimes just soft-
ening the edges that little bit is enough to make it work even if you’ve left tiny 
bits of the background or ragged edges, as you can see in the picture here.
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Apply Picture Corrections
Tweaking        brightness and contrast are pretty standard image correction procedures, as is 
sharpening a slightly blurry image.

Brightness and contrast generally work together. Brightness refers to the overall lightness or dark-
ness of a picture, and contrast refers to the difference in brightness between objects or areas in 
the image. Together, brightness and contrast can improve pictures that are a little too dark or light.

Sharpen and soften controls are more straightforward. Sharpen helps refine edges of objects in 
the image to enhance the details. Soften blurs edges of objects and contrasting regions to make 
the photo less detailed. Sharpen can help correct a slightly blurry image, but it’s not a miracle tool!

 1. Insert a picture onto your slide and select it.

 2. On the Picture Tools Format tab click Corrections and then hover over the Sharpen/
Soften options. You will see a Live Preview of what that setting would look like if 
applied to your image. Click a thumbnail to apply that setting.

 3. In the same  Corrections gallery, hover over the Brightness/Contrast thumbnails. You 
will see a Live Preview of what that setting would look like if applied to your image. 
Click a thumbnail to apply that setting.

 4. To further refine any of these settings, click Picture Corrections Options at the bottom 
of the Corrections gallery. This opens the Format Picture pane.
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 5. In the Format Picture pane, adjust 
the sharpness by moving the 
slider or typing in a specific value. 
You can also access the same 
options that were available in the 
Corrections gallery by clicking the 
Presets button.

 6. Also in the Format Picture pane, 
you can adjust the Brightness 
and Contrast settings separately. 
Move the sliders or input your 
own values for each. Select from 
the same options that were avail-
able in the Corrections gallery by 
clicking the Presets button.

 7. Click Reset to remove all Picture 
Corrections changes.

Recolor and Color Correct a Picture
PowerPoint     has quite a few color options and corrections for images, includ-
ing color saturation, color tone, and various recolor settings.

Use a Light Hand with Color Correction Tools
Saturation refers  to the intensity of color. Highly saturated images have overly 
bright colors, which usually don’t project well. Just remember that a little satu-
ration goes a long way and don’t overdo it.

The same goes for color  tone, which refers to color temperature. A lower tem-
perature value produces cool tones. With too low a temperature, the picture 
may look overly blue. Likewise, higher temperature values produce warm tones, 
which potentially make a picture look too yellow. As with saturation, a little 
tonal correction can go a long way.

6
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 1. Insert a picture onto your slide and select it.

 2. On the Picture Tools Format tab click Color and then hover over the Color Saturation 
options. You will see a Live Preview of what that setting would look like if applied to 
your image. Click a thumbnail to apply that setting.

 3. In the same  Color gallery, hover over the Color Tone thumbnails. You will see a Live 
Preview of what that setting would look like if applied to your image. Click a thumb-
nail to apply that setting.

 4. Hover over the various Recolor thumbnails to see how they affect your picture if 
applied. Your options on the top row include grayscale, sepia, washout, and various 
percentages of black and white. You also have dark and light duotone recolor options 
based on your theme colors.

 5. Click More Variations at the bottom of the Color gallery to access the complete 
theme color palette, to mix your own color in the More Colors gallery, or to use the 
Eyedropper tool to match a color anywhere on your screen.
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What Is Set Transparent Color?
You may  have noticed the  Set Transparent Color option near the bottom of the Color 
gallery. Select this tool and then click your image. All pixels that are the same as the 
clicked color will become transparent. Sounds great, right? The drawback is this tool 
makes only one specific color transparent, but most photographs use a mix of many col-
ors to create a color. For example, a white area on a picture may consist of pixels that are 
many shades of white, even though it looks like one color of white to your eye.

The point is, if you click the Set Transparent Color tool and then click your photo to 
make that color transparent, don’t be surprised if the results aren’t what you expect. 
Sometimes you’ll get lucky, but if you don’t, try using the Remove Picture Background 
tool instead.

 6. Click Picture Color Options to open the Format Picture pane, where you can enter 
your own color saturation and tone values. Access the same settings that were avail-
able from the Ribbon by clicking the Presets buttons.

 7. Click Reset to remove all color saturation, tone, and recolor settings that have been 
applied.

6
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Apply Artistic Effects
Artistic effects     apply filters to the image to make it look more like a sketch or painting.

 1. Insert a picture onto your slide and select it.

 2. On the Picture Tools Format tab, click Artistic Effects.

 3. Hover over the thumbnails to see how the effect will affect your image when applied. 
Click a thumbnail to apply it.

 4. To further refine the effect you’ve applied, click Artistic Effects Options. This opens the 
Format Picture pane.

2
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 5. If necessary, in the Effects section of 
the Format Picture pane, click Artistic 
Effects to expand those options.

 6. Use the sliders or input your own 
values for the settings applicable to 
that artistic effect.

 7. Access the Artistic Effects gallery 
from the Artistic Effects button. 
Unfortunately, you won’t see a Live 
Preview when you access the gallery 
here. Click any thumbnail to apply 
the effect.

 8. Click the Reset button to remove the 
artistic effects and settings that have 
been applied.

Artistic Effects Can Affect File Size
Artistic effects   can greatly impact your file size. This is because PowerPoint practices 
what is known as “nondestructive editing.” In other words, you can reset your picture at 
any time to remove the artistic filters and restore your original image. This requires that 
PowerPoint keep your original image as well as a copy of it with the filter applied, all of 
which contributes to a larger file size. In fact, picture compression doesn’t usually work 
on images that have artistic effects applied, and although it’s counterintuitive, using pic-
ture compression often increases the file size when artistic effects are in play!

Swap One Picture for Another
Sometimes    it’s helpful to substitute one picture for another. That’s what the Change 
Picture command is for.
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 1. Insert a picture onto your slide and select it. On the Picture Tools Format tab, apply a 
style from the Picture Styles gallery.

 2. Right-click the picture and choose Change Picture. You can also click the Change 
Picture button on the Picture Tools Format tab.

 3. The Insert Pictures dialog box that opens combines options to add pictures from your 
hard drive or from an online search or storage location. Choose a new picture and 
click Insert.

Tips for Using Change Picture
One of   the benefits of using Change Picture is not having to reformat everything when you 
want to swap one image for another. But not all picture formatting remains when you use 
Change Picture.

Styles applied from the Picture Styles gallery remain. So do picture borders and Picture 
Effects settings such as shadows, reflections, glows, soft edges, bevels, and 3-D rotation—
basically anything you see and apply in the Picture Styles group on the Picture Tools Format 
tab of the Ribbon.

Settings applied from the Adjust group are removed when you use Change Picture. These 
include remove background, brightness/contrast and sharpen/soften settings, color correc-
tions and recoloring, and artistic effects. If you need to change a picture that has these set-
tings applied, you’ll generally be better off inserting the new picture as usual and then using 
Format Painter on the Home tab to “paint” the formatting from the old to the new image.

Also, don’t use Change Picture on pictures you inserted in placeholders because strange 
things can happen to the size of the picture, and it may not fill the space as it should. 
Instead, delete the picture to get back to the empty placeholder and then click the icon in 
the placeholder to add the new picture as usual.

3
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The biggest difference between these is how they behave when you insert a picture, 
whether it’s an online picture or one from your hard drive. When you insert a picture 
into a content placeholder, the entire picture is inserted and fitted into the place-
holder as best it can. For example, if you have a square content placeholder and you 
insert a horizontal picture in it, the picture will fit the width of the placeholder and 
leave the top and bottom areas blank. Likewise, if you add a more vertical picture to 
a square content placeholder, the picture fits to the vertical size of the placeholder 
and you have blank areas on either side.

When you insert a picture into a picture placeholder, the picture is cropped, and 
the entire placeholder area is filled. If you don’t like the way PowerPoint crops your 
pictures in a picture placeholder, click the Crop button and reposition the picture 

>>>Go Further
PICTURES IN CONTENT PLACEHOLDERS 
VERSUS PICTURE PLACEHOLDERS
PowerPoint      has two kinds of placeholders that let you add pictures, and they work 
differently.

A content placeholder lets you add seven types of content: text, tables, charts, 
SmartArt graphics, pictures (from your hard drive), online pictures, and video. Most 
of the default layouts include content placeholders.

A picture placeholder lets you add only a picture. The default Picture with Caption lay-
out uses a picture placeholder. You may have custom layouts that use them as well.

Content placeholder Picture placeholder
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For you template builders, use picture placeholders if you’re creating custom layouts 
for a photo collage or a full-screen picture, for example. This way, inserted images 
fill the entire space regardless of the size or orientation of the picture itself. It’s gen-
erally less work for your users.

By the way, picture placeholders have only one Pictures icon, which inserts pictures 
from your hard drive. To insert an    online picture, go to the Insert tab and choose Online 
Pictures while you’re on any slide with an empty picture placeholder. This way you 
bypass the picture icon, and the online picture will automatically fill the placeholder. 
Inserted pictures will also automatically fill any empty content placeholders, but it’s not 
as critical with them since they have icons for both pictures and online pictures.

Compressing Pictures
With     today’s cameras and phones that take mega-megapixel pictures, it’s 
easy to end up with huge files. When this happens, you might consider using 
the Compress Pictures feature to bring them to a more manageable size.

You should know a few things about picture compression. First is that it’s on 
by default. Yes, PowerPoint automatically compresses your pictures when 
you save your file. It uses a target pixels-per-inch resolution of 220, which 
gives an adequate balance of quality versus file size for most uses. Second is 

within the crop frame as you learned earlier in this chapter. Or you can use Crop, Fit, 
and the picture will fit inside the picture placeholder just as it does with a content 
placeholder. Use Crop, Fill to go back to filling the entire placeholder area.

Content placeholder Picture placeholder
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Compress Pictures to 
Reduce File Size
Apply picture compression according 
to how you intend to use your file. 
For example, if you need to email it, 
you might want to apply maximum 
compression.

 1. Select a picture on a slide. Ideally, 
use a presentation that includes a 
number of pictures.

 2. Click the Compress Pictures but-
ton on the Picture Tools Format 
tab. This opens the Compress 
Pictures dialog box.

 3. To apply compression to all 
images in the file, uncheck 
Apply Only to This Picture.

 4. Uncheck Delete Cropped Areas of 
Pictures if you want to leave the 
cropped areas available.

 5. Select the target output resolu-
tion, which will depend on how 
you intend to use the file. Select 
E-mail (96 ppi) for maximum com-
pression. Use Web (150 ppi) if you 
plan to post your presentation 
online or project it. Choose Print 
(220 ppi) if you intend to print. 
The HD option (330 ppi) is now 
available for high-definition 
displays.

that you can still use Compress Pictures to compress more. Third is that after 
PowerPoint has compressed your images, it won’t compress them again at a 
higher resolution because that would cause your pictures to look really bad.

2
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Some Options Aren’t Available
If the  picture has already been compressed, higher-resolution compression 
options may not be available. For example, if you’ve saved the file and left 
PowerPoint’s default 220 ppi compression setting selected, you won’t be able to 
compress the image again using 330 ppi (HD).

Many images you download from the Web will already be fairly compressed, so 
many of the higher-resolution compression options may not be available for 
them. Also, although PowerPoint will let you specify compression settings for 
CMYK images, they won’t actually compress at all.

The option to Use Document Resolution refers to the resolution specified on 
the Slide Show tab in the Set Up Slide Show settings. Usually this resolution is 
the same as your computer screen, unless you consciously changed it.

It’s Not All Good
Change or Disable Automatic Compression

You   can change the automatic picture compression setting for any open file 
by going to File, Options, Advanced. In the Image Size and Quality settings, 
opt to discard editing data such as cropped areas that are used to restore an 
image to its original state, turn off compression altogether, or choose a differ-
ent target resolution setting. (The 330 ppi option is new in PowerPoint 2016.)

The biggest drawback here is you must remember to do this for every file. If 
you’re willing to edit your registry (or know someone who’s willing to do it 
for you), you can turn off automatic image compression for all PowerPoint 
files. To learn how, see the instructions at http://www.pptfaq.com/FAQ00862_
PowerPoint_2007_and_2010_make_pictures_blurry-_loses_GIF_animation.
htm. (Substitute 16.0 for 12.0 in the registry key listed.)

After disabling image compression this way, you’ll have to use Compress 
Pictures any time you want to compress the file. But at least that way you, not 
PowerPoint, choose when and how much it happens.

http://www.pptfaq.com/FAQ00862_PowerPoint_2007_and_2010_make_pictures_blurry-_loses_GIF_animation.htm
http://www.pptfaq.com/FAQ00862_PowerPoint_2007_and_2010_make_pictures_blurry-_loses_GIF_animation.htm
http://www.pptfaq.com/FAQ00862_PowerPoint_2007_and_2010_make_pictures_blurry-_loses_GIF_animation.htm
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Creating a Photo Album
If you have a bunch of pictures you want to pull together for a presentation, a 
quick way is to create a photo album. Unfortunately, the Photo Album feature 
is pretty old and doesn’t give you a way to insert  online pictures. Download 
pictures from your online storage or set up a synced folder on your hard drive 
so you can access all the images you want to include.

Create a Photo Album
Turn your    pictures into a photo album, fast.

 1. Go to File, New and start a new presentation based on the Blank Presentation theme.

 2. On the Insert tab, click Photo Album. This opens the Photo Album dialog box.

 3. Click the File/Disk button to insert pictures from your hard drive. Select pictures you 
want to include and click Insert to add them to the picture list. You can press Ctrl 
while clicking to select multiple individual pictures. To select a range of pictures, press 
Shift and click the first and last pictures in the range.

 4. Click New Text Box to create a slide with a text box you can type in later. This is useful 
to create sections throughout your photo album.
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 5. You can change the picture layout to multiple pictures or multiple pictures plus slide 
title. The default photo album uses a Fit to Slide Picture Layout, which fills each slide 
with a picture.

 6. When the  pictures don’t encompass the entire slide, you’ll be able to change the 
Frame shape to apply settings such as rounded rectangles or soft edges. The preview 
thumbnail will give you an idea of what the slide will look like.

 7. Reorder or remove pictures using the buttons below the picture list. Be sure to check 
the box beside the pictures to make these tools available.

 8. Use the buttons below the picture preview to adjust brightness and contrast or rotate 
a picture.

 9. Turn on Captions below all pictures to automatically add the filename below each 
image.

 10. Choose a theme at the bottom of the dialog box if you want. You’ll have a better 
selection of themes to choose from if you skip applying a theme here and do it after-
ward from the Design tab.

 11. After you’re finished with all the settings and picture touch-ups, click Create to make 
your photo album!

 12. Other steps to complete your photo album might include adding any necessary text, 
applying automatic transitions (Chapter 8, “Adding Animations and Transitions”), and 
setting the presentation to loop (Chapter 11, “Setting Up Your Slide Show”).
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 13. To add pictures to or otherwise edit your photo album later, go to the Insert tab and 
click the arrow next to the Photo Album button, and then choose  Edit Photo Album.

13
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1"x1" shapes, creating, 83
3-D charts, 182
3-D rotation, applying to shapes, 109
3-D SmartArt styles, editing in 2-D, 168
4:3 slides, converting to 16:9 slides, 66-68
16:9 slides, converting to 4:3 slides, 66-68

AAA
absolute colors, theme colors versus, 97
accepting changes, 268-270
accessibility checking, 279
accessing OneDrive, 14
account settings in Backstage view, 26
action settings, hyperlinks and, 292
activating Office 2016, 12-13
Add Animation gallery, when to use, 217
adding. See also applying; inserting

locations to Insert Pictures dialog 
box, 130

speaker notes, 286-288
add-ins, 21-22
adjustment handles for shapes, 90
advancing slides, 212

automatically, 213
albums (photo), creating, 155-157
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Drawing Guides, 122-123

gridlines, 124
grouping for alignment, 124-125
Smart Guides, 117-118
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text, 60-61
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distributing shapes, 120
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Android, Office apps for, 4
Animation gallery, when to use, 217
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223-224
animations
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use, 217

applying, 214-215
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Motion Path animations, 220
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Trigger animations, 222

changing, 217
of charts, 227-228
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indicators, 217
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purpose of, 209
removing, 215
reordering, 224
repeating, 225
reusing, 226
of SmartArt, 227-228
syncing with bookmarks, 251
of tables, 228
tips for motion paths, 221
transitions versus, 210
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bookmarks as, 251
for multimedia, 245-247

types of, 214
applying

animations, 214-215
Emphasis animations, 219-220
Motion Path animations, 220
multiple animations, 216-217
to text, 218
Trigger animations, 222

background styles to layouts, 327
footers, 262
quick chart styles and layouts, 189
themes to slide masters, 323-324
transitions, 210-212

arrow pointers, options during 
presentations, 297

arrows next to buttons, 19
artistic effects, applying to pictures, 

148-149
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correcting distortion in picture fills, 103
cropping pictures to, 138-139
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shapes, 82
slides, 66-68

attaching lines to shapes, 106
audio. See also multimedia
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inserting from hard drive, 232-233
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settings, 244-245

automatically versus trigger 
animations, 245-246

as background tracks, 249
inserting bookmarks, 250
“on click” animations, 246-247
syncing animation with 

bookmarks, 251
recording, 234

audio icon, hiding, 250
AutoFit feature, 53, 61
automatically advancing slides, 213
automatically playing multimedia, 

244-246
automatic picture compression, 

disabling, 154
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Available Windows gallery, 132
axis (in charts), changing

label data range, 202
value axis scale, 197-198

Axis Labels dialog box, 202

BB
background

graphics, avoiding distortion, 67-68
removing from pictures, 142-143
styles

applying to layouts, 327
formatting slide masters, 324-327

tracks, audio as, 249
Backstage view, 24-26
bevels, adding to shapes, 108
black and white settings, printing 

presentations, 270-272
blank cells in chart data ranges, 203
body fonts, 319
bold text, formatting, 54
bookmarks

inserting in multimedia, 250
syncing animations, 251

borders
tables, formatting, 176-178
videos, 242

box and whisker charts, 184
brightness (pictures), adjusting, 144-145
browser-based versions of Office, 4
builds, creating, 229
bulleted text

amount to include, 54
formatting, 59
indenting/unindenting, 52-53

buttons
with arrows, 19
with color strips, 20
split buttons, 19-20

CC
capitalization, 55

forcing, 328
CDs, saving presentations on, 313
cells (in tables)

highlighting, 175
selecting for borders, 176
splitting/merging, 179

Change Picture tool, 149-150

Change Shape tool, 91
changes, accepting/rejecting, 268-270
changing. See also editing

animations, 217
axis label data range, 202
chart data, 184-186
chart data ranges, 202
chart types, 187
colors

in charts, 190-191
of Drawing Guides, 123
SmartArt graphics, 166-167

shapes to other shapes, 91
slide layouts, 182
SmartArt diagram styles, 167-168
SmartArt diagram type, 161
value axis scale, 197-198
WordArt styles, 113

character spacing, adjusting, 55
Chart Elements gallery, inserting/removing 

chart elements, 193-194
Chart Filters icon, 200-201
charts

animating, 227-228
combination charts, creating, 188
Dark 1/Light 1 colors, 328
data

changing in Excel, 186
filtering, 200-201
hiding/unhiding, 199
highlighting, 191
inserting, 184-186
Select Data Source dialog box, 201-203

data grid, closing, 186
editing linked charts

in Excel, 206-207
in PowerPoint, 205-206

formatting
colors, 190-191
data labels, 194-195
Format Data Series pane, 192
inserting/removing elements, 193-194
manual formating, 192
numbers, 196-197
quick styles and layouts, 189
text, 190
value axis scale, 197-198

inserting, 182-183
from Excel, 203-205

new features, 7
selecting, 187
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types of, 181-182
changing, 187
new chart types, 184

choosing. See selecting
circles

cropping pictures to, 140
drawing, 82

clearing formatting, 56
clicking multimedia

automatically versus trigger animations, 
245-246

“on click” animations, 246-247
for playback, 244-245

closing
data grid, 186
presentations in Backstage view, 25

collaboration
reviewing presentations, 262

inserting comments, 263
real-time collaboration, 267
Review and Compare feature, 268-270
sharing files, 265-267
writing on slides, 264

sections
creating, 256-257
in Presenter view, 258

collapsing Ribbon, 19
color correcting pictures, 145-147
Color gallery, 146
color sets

applying to slide masters, 323-324
creating custom, 319
selecting for themes, 317-319

color strips, buttons with, 20
Colorful theme, 5
colors

charts, changing, 190-191
fill colors

gradient fills, 101-102
picture/texture fills, 103-104
selecting with Eyedropper tool, 100
for shapes, 95-96

of Drawing Guides, changing, 123
in notes pages, 276
selecting with Eyedropper tool, 56
shading in table formatting, 174-176
SmartArt graphics, changing, 166-167
of text, changing, 56
theme colors versus absolute colors, 97
video editing, 243

column charts, 181
Column + Line charts, 188
columns

in tables, resizing, 172-173
text in, 60

combination charts, creating, 188
Combine (merging shapes), 92
commands in PowerPoint Options dialog box, 

42-43
comments

inserting, 263
printing, 273
removing with Inspect Document, 280-281

Comments pane, 28
viewing/hiding, 263

comparing presentations, 268-270
compatibility

checking, 278
optimizing for, 252

compressing
multimedia, 253
optimizing versus, 253
pictures, 152-154

configuring presentation setup, 285-286. See 
also setting up presentation

action settings, 292
custom shows, 293-294
hiding slides, 288-289
inserting hyperlinks, 289-291
Set Up Slide Show command, 294-295
speaker notes, 286-288

connectors
attaching to shapes, 106
formatting, 104-106

content placeholders, 51
picture placeholders versus, 151-152

contextual tabs, 18
contrast (pictures), adjusting, 144-145
converting

drawings to shapes, 265
pictures to SmartArt graphics, 132-133
slide aspect ratios, 66-68
SmartArt to text, 164
text to SmartArt, 164

copying. See also duplicating
formatting, 111
slides into presentations, 68-71

copyright
Creative Commons, 130
for pictures, 127
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correcting distortion in picture fills, 103
Corrections gallery, 144
corrections to pictures, 144-145
creating presentations, 45. See also applying; 

inserting
adding slides, 48-51
selecting theme, 46-47

Creative Commons, 130
cropping

pictures
to aspect ratio, 138-139
with crop handles, 135-136
with number settings, 137
to placeholders, 140
to shapes, 139-140

videos, 240
Ctrl key, Shift key versus, 87
custom color sets, creating, 319
custom print ranges, 274
custom shows, creating, 293-294
custom slide layouts

creating, 332-334
when to use, 334

custom sounds for transitions, 211
customizing. See also configuring presentation 

setup
gradient fills, 101-102
Quick Access Toolbar, 37-41

D
Dark 1 colors, 318

in charts, 328
formatting placeholders, 328

Dark 2 colors, 318
Dark Gray theme, 6
data (in charts)

changing
in Excel, 186
value axis scale, 197-198

filtering, 200-201
Format Data Series pane, 192
hiding/unhiding, 199
highlighting, 191
inserting, 184-186
Select Data Source dialog box, 201-203

data grid, closing, 186
data labels, formatting, 194-195
dates, inserting in footer placeholders, 261

default presentation application, PowerPoint 
2016 as, 12

default Quick Access Toolbar, restoring, 40
default shapes, setting, 112
delay in animations, 215

setting, 223-224
deleting. See removing
delivering presentations

hiding pop-up toolbar, 297
methods of, 312
navigating slide shows, 297-300
online presentations, 304-306
Package for CD option, 313
as PDF, 309-311
as picture presentations, 308-309
Presenter view, 300-303
starting Slide Show view, 296
swapping Slide Show view and Presenter 

view, 296, 303
as video, 306-307

demoting
bulleted text, 52-53
text in SmartArt graphics, 163

designing presentations, best practices, 73
destination formatting, troubleshooting, 71
diagrams. See SmartArt graphics
digital signatures, 282
disabling automatic picture compression, 154
displaying. See viewing
distortion

avoiding
when resizing pictures, 134
when resizing slides, 66-68

correcting in picture fills, 103
distributing shapes

alignment tools, 120
Smart Guides, 117-118
tips for, 121

Document Inspector, 280-281
dragging

data labels, 195
timeline, 224

drawing
lines with Freeform tool, 93
shapes, 82-84
straight lines, 105

Drawing Guides, aligning shapes, 122-123
drawings, converting to shapes, 265
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duplicating. See also copying
animations, 226
shapes, 85-86
slide layouts, 334

duration
of animations, 215

setting, 223-224
of transitions, 211

dynamic paste preview, 36

EE
Edit Points tool, 93

with motion paths, 221
editing. See also changing

3-D SmartArt styles, 168
charts from Excel

in Excel, 206-207
in PowerPoint, 205-206

multimedia, 236-237
cropping videos, 240
fading in/out, 238-239
inserting video poster frames, 239-240
trimming time, 237-238

photo albums, 157
presentations

permissions for, 266
Show files, 78

editing workspace (Normal view), 28-29
effects sets

applying to slide masters, 323-324
selecting for themes, 321-322

email, sharing presentations, 265-267
embed codes for YouTube videos, 234
embedded documents, removing with Inspect 

Document, 280-281
embedded fonts, 59

in templates, 320
embedding

Excel charts, 204-205
multimedia

from hard drive, 232
online video, 233-234

Emphasis animations, 214
applying, 219-220

empty placeholders in Slide Show view, 49
Entrance animations, 214
erasing pen strokes, 264
Excel

changing chart data, 186

inserting charts from, 203
editing linked charts in Excel, 206-207
editing linked charts in PowerPoint, 

205-206
linking and embedding, 204-205

Exit animations, 214
expanding Shapes gallery, 82
exporting presentations in Backstage view, 25
extensions, viewing, 78
Eyedropper tool, 56, 100

FF
fading in/out

continuously in animations, 226
multimedia, 238-239

feedback, sending to Microsoft, 26
file extensions, viewing, 78
file formats

for multimedia, 231-232
for presentations, 307-308

file size
of pictures, 149

reducing via compression, 152-154
saving presentations as videos, 307

files, managing in Backstage view, 24-26
fill colors

gradient fills
customizing, 101-102
for tables, 175

picture fills, 103-104
for tables, 175
in WordArt, 113-115

selecting with Eyedropper tool, 100
for shapes, 95-96

filtering chart data, 200-201
filters, applying to pictures, 148-149
finding Shapes gallery, 85
fixed axis scale, creating, 197-198
flipping shapes, 83-84
folders, creating on OneDrive, 75
font sets

applying to slide masters, 323-324
selecting for themes, 319-320

font sizes, adjusting, 55
fonts. See also text

changing, 55
Dark 1/Light 1 colors, 328
embedded fonts, 59

in templates, 320
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formatting in SmartArt graphics, 169
selecting background styles, 325
theme fonts, 58-59

footers
applying, 262
hiding

placeholder content, 329
on title slides, 262

inserting placeholders, 259-260
populating placeholders, 261-262
requirements for, 258-259
troubleshooting placeholders, 260-261

forcing capitalization, 328
format codes, 197
Format Data Series pane, 192
Format Painter, 111
Format Picture pane, 35

cropping pictures with number 
settings, 137

Format Shape pane, 34-35, 98
advanced shape effects, 110
fill colors, 96

formatting
charts

colors, 190-191
data labels, 194-195
Format Data Series pane, 192
inserting/removing elements, 193-194
manual formating, 192
numbers, 196-197
quick styles and layouts, 189
text, 190
value axis scale, 197-198

multimedia, 236-237
video styles, 241-243

photo albums, 156
pictures, 140

artistic effects, 148-149
Change Picture tool, 150
color correction, 145-147
corrections, 144-145
removing background, 142-143
styles, 141

placeholders, 51
shapes

3-D rotation, 109
advanced effects, 110
bevels, 108
copying formatting, 111
Eyedropper tool, 100
fill colors, 95-96

Format Shape pane, 98
Formatting pane, 34-35
gradient fills, 101-102
lines/connectors/outlines, 104-106
picture/texture fills, 103-104
setting default shape, 112
shadows, 107
Shape Styles gallery, 94-95
theme colors versus absolute colors, 97

slide layouts
individual slides, 330-332
Title Slide layout, 329-330

slide masters
background styles, 324-327
positioning placeholders, 327-329
theme colors/fonts/effects, 323-324

slides, troubleshooting destination 
formatting, 71

SmartArt graphics
changing colors, 166-167
changing styles, 167-168
fonts, 169
resetting to original, 168
with shape styles, 167

tables
borders, 176-178
quick styles, 173-174
shading, 174-176
splitting/merging cells, 179
text, 178-179

text, 51, 54-59
indents and tabs, 63-65
line spacing, 62-63
with Mini Toolbar, 23
paragraph settings, 59-63
theme fonts, 58-59

text boxes, 94
WordArt, 112

Formatting pane, 21, 34-35
Fragment (merging shapes), 92
Freeform tool, 93

GG
galleries, resizing, 20
gradient fills

customizing, 101-102
for tables, 175

graphics. See shapes; SmartArt graphics
gray in charts, 191
grayscale settings, printing presentations, 

270-272
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grid, viewing slides, 298-299
gridlines, viewing, 124
grouping shapes for alignment, 121, 124-125
groups (in Ribbon), 18-19
guides

Drawing Guides, aligning shapes, 122-123
formatting slide layouts, 330
Smart Guides

aligning shapes, 117-118
new features, 7

tips for, 123

H
Handout Master view, 32
handouts

creating in Word, 277
notes pages as, 276
printing, 274-275

hard drive
inserting

multimedia files from, 232-233
pictures from, 128

saving presentations to, 76-77
headers and footers. See footers
Heading fonts, 319
hidden objects, removing with Inspect 

Document, 280-281
hidden slides, printing, 273
hiding

audio icon, 250
chart data, 199
Comments Pane, 263
footers

placeholder content, 329
on title slides, 262

Media Controls, 248
pop-up toolbar, 297
slides, 288-289

highlighters, 264
highlighting

chart data, 191
table cells, 175

histogram charts, 184
Home tab, 18-19
hyperlinks

to custom shows, 294
inserting, 289-290

action settings and, 292
best practices, 291

II
images. See pictures
importing Quick Access Toolbar, 41
indent settings, 63-65
indenting bulleted text, 52-53
indicators for animations, 217

text and, 219
Trigger animations, 222

Info screen, 24
ink tools, 264

new features, 8-9
printing markup, 273

Insert Pictures dialog box, adding locations 
to, 130

inserting
bookmarks in multimedia, 250
chart data, 184-186
chart elements, 193-194
charts, 182-183

from Excel, 203-205
combination charts, 188
comments, 263
dates/times in footer placeholders, 261
Drawing Guides, 123
hyperlinks, 289-290

action settings and, 292
best practices, 291

logos on notes pages, 276
multimedia

from hard drive, 232-233
online video, 233-234

pictures
content versus picture placeholders, 

151-152
from hard drive, 128
online pictures, 129-130, 152
screenshots, 131-132
in SmartArt graphics, 165

placeholders in footers, 259-260
poster frames, 239-240
sections, 256-257
shapes, 82-84

in SmartArt graphics, 162-164
slide numbers in footer placeholders, 261
slides

existing slides, 68-71
new slides, 48-51
Reuse Slides tool, 71-72

SmartArt graphics, 160-161
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tables, 170-171
text

amount to include, 54
in footer placeholders, 261
in placeholders, 52-54
in shapes, 84-85
in SmartArt graphics, 162-164

text boxes in shapes, 84-85
inside borders for table cells, 177
Insights feature, 10
Inspect Document feature, 280-281
installing Office 2016, 11-14
interface, 14

Backstage view, 24-26
dynamic paste preview, 36
Formatting panes, 34-35
Mini Toolbar, 23
Normal view, 28-29
Office themes, new features, 5-6
Paste Options, 36
Quick Access Toolbar, customizing, 37-41
Ribbon, 18-22
shortcut menu, 23
Start screen, 15-17
views, explained, 29-34

interpolation, 203
Intersect (merging shapes), 92
iOS devices, Office apps for, 4
italic text, formatting, 54

JJ–KK–LL
jumping to sections, 290

Keep Source Formatting option, 36
Keep Text option, 36
keyboard shortcuts, starting presentations, 296
Kiosk mode, 295

 labels
changing data range, 202
formatting, 194-195

layers, 89
layouts (charts), quick styles and layouts, 189
layouts (slides)

applying background styles, 327
changing, 182
creating custom, 332-334
deleting, 332
duplicating, 334

formatting
individual slides, 330-332
Title Slide layout, 329-330

inserting pictures, 128
orphaned layouts, troubleshooting, 71
orphaned placeholders in, 51
selecting, 50
slide masters, relationship with, 323
when to use custom layouts, 334

licensing, Creative Commons, 130
Light 1 colors, 318

in charts, 328
formatting placeholders, 328

Light 2 colors, 318
line charts, 181
line spacing

adjusting, 61
tips for, 62-63

lines
attaching to shapes, 106
drawing with Freeform tool, 93
formatting, 104-106

setting default, 112
straight lines, drawing, 105

linking. See also hyperlinks
Excel charts, 204-205

editing in Excel, 206-207
editing in PowerPoint, 205-206

multimedia
from hard drive, 233
online video, 233-234

locations, adding to Insert Pictures dialog 
box, 130

logos, inserting on notes pages, 276
looping presentations, 294

MM
managing

data series, 202
files in Backstage view, 24-26

manually formating charts, 192
Mark as Final feature, 282
media. See multimedia
Media Controls, viewing/hiding, 248
Merge Shapes tool, 91-92
merging

shapes, 91-92
table cells, 179
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Microsoft Office. See Office 2016
Microsoft PowerPoint. See PowerPoint 2016
Mini Toolbar, 23

text formatting, 57
Motion Path animations, 214

applying, 220
tips for, 221

moving
data labels, 194-195
Drawing Guides, 123
pictures in shapes/text, 115
within tables, 171-172

.MOV video files, 232
multimedia. See also audio; video

compressing, 253
editing, 236-237

cropping videos, 240
fading in/out, 238-239
inserting video poster frames, 239-240
trimming time, 237-238

formats supported, 231-232
formatting, 236-237

video styles, 241-243
inserting

from hard drive, 232-233
online video, 233-234

optimizing compatibility, 252
playing

audio background tracks, 249
automatically or when clicked settings, 

244-245
automatically versus trigger animations, 

245-246
inserting bookmarks, 250
“on click” animations, 246-247
syncing animation with bookmarks, 251
video playback options, 248

recording
audio, 234
screen recordings, 235-236

royalty free, 231
multiple animations, applying, 216-217
multiple shapes, selecting, 87
multiple slides, selecting, 210

N
navigating

slides during presentations, 297-300
tables, 171-172

new features
chart types, 7
Insights, 10
Office themes, 5-6
picture compression options, 7
recording ink, 8-9
screen recordings, 9
Smart Guides, 7
Tell Me, 10
video resolution, 8

New Slide button, 51
nondestructive editing, 238
Normal view, 28-29
notes pages

printing, 275-276
removing with Inspect Document, 280-281

Notes Page view, 30, 32, 288
Notes pane, 28

adding speaker notes, 286-288
typing extra text on, 54

numbered text, formatting, 59
numbers

format codes, 197
formatting in charts, 196-197

OO
Office 365

installing Office 2016, 11-14
Office 2016 versus, 4

Office 2016, 3
activating, 12-13
installing, 11-14
Office 365 versus, 4

Office for Android, 4
Office for iPad and iPhone, 4
Office Mix, new features, 9
Office Mobile, 4
Office Online, 4
Office themes. See themes
Office Universal for Windows 10, 4
off-theme colors, 97
“on click” animations for multimedia, 246-247
one-click formatting, WordArt, 112
OneDrive

accessing, 14
creating folders, 75
saving presentations to, 74-75
security considerations, 282
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online pictures
inserting, 129-130, 152
in photo albums, 155

online presentations, delivering, 304-306
online video, inserting, 233-234
Open screen, 16-17
Open XML Paper Specification (XPS), 311
opening

PowerPoint 2016, 14
presentations, 45

in Backstage view, 24
optimizing

compressing versus, 253
multimedia compatibility, 252

Options dialog box. See PowerPoint Options 
dialog box

Order Objects tools, 89
organization charts, 164
orphaned footers, 260
orphaned layouts, 71
orphaned placeholders, 51
Outline view, 29-30
outlines

formatting, 104-106
printing, 275
removing, 106

Outlook, sharing presentations, 266

PP
Package for CD option, 313
paragraphs, formatting

indents and tabs, 63-65
spacing and alignment, 59-63

passwords, encrypting with, 282
Paste Options, 36
pasting

with dynamic paste preview, 36
slides into presentations, 68-71

pausing when recording audio, 234
PDFs

printing to, 311
saving presentations as, 309-311

Pens gallery, 264
permissions, viewing/editing presentations, 266
photo albums, creating, 155-157
photos. See pictures
picture compression, new features, 7

picture fills, 103-104
for tables, 175
in WordArt, 113-115

Picture option, 36
picture placeholders, content placeholders 

versus, 151-152
picture presentations, saving, 308-309
Picture Styles gallery, 141
pictures, 127

compressing, 152-154
converting to SmartArt graphics, 132-133
copyright issues, 127
cropping

to aspect ratio, 138-139
with crop handles, 135-136
with number settings, 137
to placeholders, 140
to shapes, 139-140

file size, 149
formatting, 140

artistic effects, 148-149
Change Picture tool, 150
color correction, 145-147
corrections, 144-145
removing background, 142-143
styles, 141

inserting
content versus picture placeholders, 

151-152
from hard drive, 128
online pictures, 129-130, 152
screenshots, 131-132
in SmartArt graphics, 165

moving in shapes/text, 115
photo albums, creating, 155-157
recoloring in SmartArt graphics, 166
resizing, 134-135
swapping, 149-150

pie charts, 182
pinning themes to Start screen, 16, 47
placeholders

advantages of, 50
content versus picture placeholders, 

151-152
cropping pictures to, 140
empty placeholders in Slide Show view, 49
footer placeholders

hiding content, 329
inserting, 259-260
populating, 261-262
troubleshooting, 260-261
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formatting, 51
inserting text, 52-54
orphaned placeholders, 51
positioning on slide masters, 327-329
types of, 51

playing multimedia
audio background tracks, 249
automatically or when clicked settings, 

244-245
automatically versus trigger animations, 

245-246
inserting bookmarks, 250
“on click” animations, 246-247
syncing animation with bookmarks, 251
video playback options, 248

pointers, options during presentations, 297
populating placeholders in footers, 261-262
pop-up toolbar, hiding, 297
positioning

data labels, 194-195
placeholders on slide masters, 327-329
shapes with Smart Guides, 117-118

poster frames, inserting, 239-240
PowerPoint 2016

as default presentation application, 12
interface. See interface
new features

chart types, 7
Insights, 10
Office themes, 5-6
picture compression options, 7
recording ink, 8-9
screen recordings, 9
Smart Guides, 7
Tell Me, 10
video resolution, 8

Office versions available, 3-5
opening, 14

PowerPoint Options dialog box, 26
symbols in, 42-43
what to set, 26-27

PowerPoint Viewer, delivering presentations 
with, 313

Presentation files, Show files versus, 77
presentations

closing in Backstage view, 25
compressing multimedia, 253
creating, 45

adding slides, 48-51
in Backstage view, 24
selecting theme, 46-47

delivering
hiding pop-up toolbar, 297
methods of, 312
navigating slide shows, 297-300
online presentations, 304-306
Package for CD option, 313
as PDF, 309-311
as picture presentations, 308-309
Presenter view, 300-303
starting Slide Show view, 296
swapping Slide Show view and Presenter 

view, 296, 303
as video, 306-307

designing, best practices, 73
editing

permissions for, 266
Show files, 78

exporting in Backstage view, 25
footers. See footers
looping, 294
opening, 45

in Backstage view, 24
optimizing compatibility, 252
printing

in Backstage view, 25
black and white settings, 270-272
handouts, 274-275
notes pages, 275-276
to PDF, 311
specific slides, 272-274

protecting, 281-282
publishing

accessibility checking, 279
compatibility checking, 278
Inspect Document feature, 280-281

recording, new features, 8-9
reviewing, 262

inserting comments, 263
real-time collaboration, 267
Review and Compare feature, 268-270
sharing files, 265-267
writing on slides, 264

running side by side, 295
saving, 73

in Backstage view, 24-25
to hard drive, 76-77
to OneDrive, 74-75
as PDF, 309-311
as picture presentations, 308-309
Show files versus Presentation files, 77
as video, 306-307
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sections
creating, 256-257
in Presenter view, 258

sharing
in Backstage view, 25
methods of, 312
Present Online option, 304-306

slides. See slides
structure setup, 285-286

action settings, 292
custom shows, 293-294
hiding slides, 288-289
inserting hyperlinks, 289-291
Set Up Slide Show command, 294-295
speaker notes, 286-288

viewing, permissions for, 266
Presenter view, 34, 285

sections in, 258
Slide Show view versus, 299
swapping with Slide Show view, 296, 303
tips for, 300-303

Present Online option, 304-306
printing

handouts, 274-275
notes pages, 275-276
outlines, 275
presentations

in Backstage view, 25
black and white settings, 270-272
to PDF, 311
specific slides, 272-274

promoting
bulleted text, 52-53
text in SmartArt graphics, 163

proportions, maintaining when resizing 
pictures, 134. See also aspect ratio

protecting presentations, 281-282
publishing presentations. See also sharing 

presentations
accessibility checking, 279
compatibility checking, 278
Inspect Document feature, 280-281

QQ––RR
Quick Access Toolbar, customizing, 37-41
quick layouts (charts), applying, 189
quick styles, formatting tables, 173-174
QuickTime player, 232

ranges for printing, 274

Reading view, 29, 31
real-time collaboration, 267
rearranging Quick Access Toolbar tools, 39
recent colors in Shape Fill gallery, 96
Recent Files list, 16-17
Recently Used Shapes section (Shapes 

gallery), 85
recoloring pictures, 145-147

in SmartArt graphics, 166
recording

multimedia
audio, 234
screen recordings, 235-236

screen, new features, 9
slideshows, new features, 8-9

Record Sound dialog box, 234
reducing file size of pictures, 152-154
rejecting changes, 268-270
removing

animations, 215
background from pictures, 142-143
bookmarks in multimedia, 250
chart background animation, 228-229
chart elements, 193-194
comments, 263
Drawing Guides, 123
extra content with Inspect Document, 

280-281
outlines, 106
Quick Access Toolbar tools, 39
sections, 256
slide layouts, 332

renaming
sections, 256
shapes

for animations, 224
in Selection pane, 88

reordering
animations, 224
sections, 257
shapes

with Order Objects tools, 89
with Selection pane, 89

repeating
animations, 225
slides in custom shows, 293

resetting
SmartArt formatting, 168
video formatting, 243
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resizing
columns/rows in tables, 172-173
galleries, 20
pictures, 134-135
shapes, 82-84

AutoFit feature, 61
slides, 66-68, 72
tables, 172-173

resolution
for compressed pictures, 154
saving presentations as videos, 307

restoring
default Quick Access Toolbar, 40
Ribbon, 19

Reuse Slides tool, 71-72
reusing

animations, 226
slides

copying/pasting into presentations, 68-71
Reuse Slides tool, 71-72

Review and Compare feature, 268-270
reviewing presentations, 262

inserting comments, 263
real-time collaboration, 267
Review and Compare feature, 268-270
sharing files, 265-267
writing on slides, 264

Revisions Pane, 269
Ribbon, 18-22
rotating

shapes, 82-84
3-D rotation, 109

text, 61
videos, 242

rounded corners on shapes, adjusting, 90
rows in tables, resizing, 172-173
royalty-free multimedia, 231
Ruler, indents and tabs, 63-65

S
saturation (color), 145
saving

presentations, 73
in Backstage view, 24-25
to hard drive, 76-77
to OneDrive, 74-75
as PDF, 309-311
as picture presentations, 308-309
Show files versus Presentation files, 77
as video, 306-307

Quick Access Toolbar, 41
templates, 335-336
themes, 336-337

screen, recording, 9, 235-236
screen readers, accessibility checking, 279
screenshots, inserting, 131-132
searching for themes, 47
sections

creating, 256-257
jumping to, 290
in Presenter view, 258

security, protecting presentations, 281-282
Select Data Source dialog box, 201-203
selecting

background styles, 325
chart elements, 194
charts, 187
color sets for themes, 317-319
colors with Eyedropper tool, 56
comments, 263
effects sets for themes, 321-322
fill colors with Eyedropper tool, 100
font sets for themes, 319-320

multiple slides, 210
shapes

by clicking, 86-87
with Selection pane, 87-89

slide layouts, 50
SmartArt graphics, 162
table cells for borders, 176
text, 58

adding tabs, 65
themes for new presentations, 46-47
within tables, 171-172

Selection pane, 87-89
Send to Word feature, creating handouts, 277
sending feedback to Microsoft, 26
separators, 40
series (in charts)

changing chart type, 187
managing, 202

settings in PowerPoint Options dialog box
symbols in, 42-43
what to set, 26-27

setting up presentation, 285-286
custom shows, 293-294
hiding slides, 288-289
inserting hyperlinks, 289-290

action settings and, 292
best practices, 291
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Set Up Slide Show command, 294-295
speaker notes, 286-288

Set Transparent Color tool, 147
Set Up Slide Show command, 294-295
shading, table formatting, 174-176
shadowed text, formatting, 54
shadows, adding to shapes, 107
Shape Effects Preset gallery, 110
Shape Fill gallery, 95-96
shapes

adjustment handles, 90
aligning

alignment tools, 119
Drawing Guides, 122-123
gridlines, 124
Smart Guides, 117-118
tips for, 121

animations. See animations
attaching lines to, 106
changing to other shapes, 91
converting drawings to, 265
cropping pictures to, 139-140
distributing

alignment tools, 120
Smart Guides, 117-118
tips for, 121

duplicating, 85-86
editing videos into, 242
Edit Points tool, 93
fading in/out continuously, 226
flipping, 83-84
formatting

3-D rotation, 109
advanced effects, 110
bevels, 108
copying formatting, 111
Eyedropper tool, 100
fill colors, 95-96
Format Shape pane, 98
Formatting pane, 34-35
gradient fills, 101-102
lines/connectors/outlines, 104-106
picture/texture fills, 103-104
setting default shape, 112
shadows, 107
Shape Styles gallery, 94-95
in SmartArt graphics, 167
theme colors versus absolute colors, 97

grouping for alignment, 121, 124-125

inserting, 82-84
in SmartArt graphics, 162-164

merging, 91-92
moving pictures in, 115
outlines, removing, 106
pasting, dynamic paste preview, 36
renaming

for animations, 224
in Selection pane, 88

reordering
with Order Objects tools, 89
with Selection pane, 89

resizing, 82-84
AutoFit feature, 61

rotating, 82-84
selecting

by clicking, 86-87
with Selection pane, 87-89

text, inserting, 84-85
text boxes, inserting, 84-85

Shapes gallery
expanding, 82
finding, 85
inserting

shapes, 82
text boxes, 84

Recently Used Shapes section, 85
Shape Styles gallery, 94-95
sharing presentations, 265-267. See also 

publishing presentations
in Backstage view, 25
methods of, 312
Present Online option, 304-306

sharpening pictures, 144-145
Shift key, Ctrl key versus, 87
shortcut menu, 23
Show files

editing, 78
Presentation files versus, 77

showing. See viewing
side by side presentations, 295
size of text, adjusting, 55
Skype for Business, 304
slide masters

formatting
background styles, 324-327
positioning placeholders, 327-329
theme colors/fonts/effects, 323-324

layouts, relationship with, 323
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Slide Master view, 32
slide numbers, inserting in footer 

placeholders, 261
Slide Show view, 32

empty placeholders, 49
Presenter view versus, 299
starting, 296
swapping with Presenter view, 296, 303

Slide Size tool, 66-67, 72
Slide Sorter view, 29-30

creating sections, 256-257
slides

advancing, 212-213
changing layout, 182
destination formatting, troubleshooting, 71
footers. See footers
hiding, 288-289
inserting

existing slides, 68-71
new slides, 48-51
Reuse Slides tool, 71-72

layouts
applying background styles, 327
creating custom, 332-334
deleting, 332
duplicating, 334
formatting individual slides, 330-332
formatting Title Slide layout, 329-330
inserting pictures, 128
orphaned placeholders in, 51
selecting, 50
slide masters, relationship with, 323
when to use custom layouts, 334

navigating during presentations, 297-300
placeholders. See placeholders
printing, 272-274
repeating in custom shows, 293
resizing, 66-68, 72
reusing

copying/pasting into presentations, 68-71
Reuse Slides too, 71-72

selecting multiple slides, 210
title slides, hiding footers, 262
transitions

applying, 210-212
types of, 212

viewing in grid, 298-299
writing on, 264

slideshows. See presentations
Slides pane, 28

SmartArt graphics, 159
animating, 227-228
changing diagram type, 161
converting

pictures to, 132-133
text to/from, 164

formatting
changing colors, 166-167
changing styles, 167-168
fonts, 169
resetting to original, 168
with shape styles, 167

inserting, 160-161
pictures

inserting, 165
recoloring, 166

selecting, 162
text/shapes, inserting, 162-164

Smart Guides
aligning shapes, 117-118
new features, 7

softening pictures, 144-145
sounds for transitions, 211
spacing (of text), adjusting, 55
speaker notes

adding, 286-288
printing, 275-276
removing with Inspect Document, 280-281

split buttons, 19-20
splitting table cells, 179
squares, drawing, 82
Start screen, 15-17
starting Slide Show view, 296
straight lines, drawing, 105
strikethrough text, formatting, 54
styles

charts, quick styles and layouts, 189
formatting pictures, 141
video, 241-243
WordArt, changing, 113

Subtract (merging shapes), 92
sunburst charts, 184
swapping

pictures, 149-150
Slide Show view and Presenter view, 

296, 303
symbols in PowerPoint Options dialog box, 

42-43
syncing animations with bookmarks, 251
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TT
tab settings, 63-65
tables

adding tabs, 65
animating, 228
cells, highlighting, 175
formatting

borders, 176-178
quick styles, 173-174
shading, 174-176
splitting/merging cells, 179
text, 178-179

inserting, 170-171
navigating, 171-172
resizing, 172-173

tabs (in Ribbon), 18-19
Tell Me feature, 10
templates

embedded fonts, 320
layouts. See layouts (slides)
saving, 335-336
slide masters. See slide masters
themes versus, 47, 315-316

text
Alt Text, adding to objects, 279
applying animations, 218
capitalization, 55
converting to/from SmartArt, 164
Dark 1/Light 1 colors, 328
formatting, 51, 54-59

in charts, 190
indents and tabs, 63-65
line spacing, 62-63
with Mini Toolbar, 23
paragraph settings, 59-63
in SmartArt graphics, 169
in tables, 178-179
theme fonts, 58-59

inserting
amount to include, 54
in footer placeholders, 261
in placeholders, 52-54
in shapes, 84-85
in SmartArt graphics, 162-164

moving pictures in, 115
pasting, dynamic paste preview, 36
in rotated shapes, aligning, 84
selecting, 58

adding tabs, 65

WordArt
changing styles, 113
one-click formatting, 112
picture fills, 113-115
transforms, 114

text boxes
formatting, 94

setting default, 112
inserting in shapes, 84-85
resizing with AutoFit feature, 61

texture fills, 103-104
theme fonts, 58-59
themes

absolute colors versus theme colors, 97
applying to slide masters, 323-324
chart colors and, 191
creating

color sets, 317-319
effects sets, 321-322
font sets, 319-320

new features, 5-6
pinning to Start screen, 16, 47
saving, 336-337
searching for, 47
selecting for new presentations, 46-47
Shape Styles gallery and, 95
templates versus, 47, 315-316

timeline, dragging, 224
times, inserting in footer placeholders, 261
timing, advancing slides automatically, 213
title placeholders, 51
Title Slide layout, formatting, 329-330
title slides, hiding footers, 262
tones (color), 145
toolbars

pop-up toolbar, hiding, 297
Quick Access Toolbar, customizing, 37-41

transforms (text), 114
transitions

advancing slides automatically, 213
animations, 210
applying, 210-212
types of, 212

transparent color, setting, 147
treemap charts, 184
trigger animations

applying, 222
bookmarks as, 251
for multimedia, 245-247



355zooming in/out

trimming multimedia, 237-238
troubleshooting

applying footers, 262
Autofit feature, 61
destination formatting, 71
distorted background graphics, 67-68
editing linked charts, 206
orphaned placeholders, 51
placeholders in footers, 260-261
printing slides, 273
removing picture backgrounds, 143
swapping Slide Show view and Presenter 

view, 296, 303
Trust Center, 27
typing. See inserting

UU
underlined text, formatting, 54
unhiding chart data, 199
unindenting bulleted text, 52-53
Union (merging shapes), 92
Use Destination Theme option, 36

VV
value axis scale, changing, 197-198
video. See also multimedia

cropping, 240
editing, 236-237

fading in/out, 238-239
inserting poster frames, 239-240
trimming time, 237-238

formats supported, 231-232
formatting, video styles, 241-243
inserting

from hard drive, 232-233
online video, 233-234

playing
automatically or when clicked settings, 

244-245
automatically versus trigger animations, 

245-246
inserting bookmarks, 250
“on click” animations, 246-247
playback options, 248
syncing animation with bookmarks, 251

recording screen, 235-236
resolution, new features, 8
rotating, 242
saving presentations as, 306-307

Video Effects Presets, 243
Video Styles gallery, 241
viewing

Comments Pane, 263
file extensions, 78
gridlines, 124
hidden slides, 289
Media Controls, 248
Notes Pages, 288
presentations, permissions for, 266
slides in grid, 298-299

views, explained, 29-34

WW–Z
waterfall charts, 184
White theme, 5
.WMV video files, 232
Word, creating handouts, 277
WordArt

one-click formatting, 112
picture fills, 113-115
styles, changing, 113
in tables, 179
text transforms, 114

writing on slides, 264

XPS (Open XML Paper Specification), 311

YouTube videos, embed codes, 234

zooming in/out, 29
in Presenter view, 302
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